
Case Study: All Atom Molecular Dynamics Simulation of LFA-I 
Complex with Lovastatin

This tutorial is designed as a case study that demonstrates a drug complexing with its protein target:

This tutorial consists of this introduction page and six subsections as follows:

    1) Building the Structure.
     2) Creating the topology and coordination files.
     3) Minimizing the structure.
     4) Heating the system up.
     5) Production MD.
     6) Analyzing the Results

The procedure will also follow those sections step-by-step.

WARNING 1: some of the calculations in this tutorial can take a very long time to run. While I urge 
you to run these simulations in order to familiarize yourself with SANDER I provide the relevant 
output files so that you can still follow the tutorial even if you don't have sufficient computing power 
at your disposal.

WARNING 2: There is no guarantee that if you run these simulations yourself that you will get the 
exact same answers as I. Difference in machine architecture leads to rounding errors in the 
calculation which result in different simulations on different machines exploring different regions of 
phase space. The average properties, however, should be comparable. As you will see though as you 
progress through this tutorial there is no guarantee that you can reproduce the results described 
here.

Introduction
Wednesday, February 14, 2018 1:03 PM
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Prepare your working folder:
mkdir (make directory)
You'll need a new directory for the files and folders created in this tutorial. 
$ mkdir LFA-1 

cd (change directory)
At this point, you'll want to move into your Tutorial directory so that you can save all of your 
working files there. 
$ cd LFA-1

There is a special directory named "..". This means the parent of the current directory. So to return 
to the parent of the Tutorial directory use cd .. $ cd ..
If you ever need to return to your home directory use just the cd command by itself. Tilde "~" is a 
shortcut to your home directory. The following commands both change directory to your home 
directory. $ cd
$ cd ~ 

ls (list)
Now when you do ls you should see your new directory has been created. 
$ ls

pwd (print working directory)
Pathnames describe what directory you are in relative to the entire computer's filesystem. You 
home directory has location within the entire filesystem.

Print the working directory pathname of your home directory with pwd. $ cd
$ pwd
/home/username This is the current working directory that you're located in. In this case the 
directory username is in the directory home which is in the / (root) directory. 

Prepare PDB
$ cd LFA-1
$ mkdir PDB
The directory will be created as ~/LFA-1/PDB/

Download PDB
Download PDB file from protein data bank, PDB ID is 1CQP, and save the pdb file under 
~/LFA-1/PDB/ directory. 

Section-1: Building the structure
2018年2月14日 下午 01:02
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1cqp

Check your PDB with Chimera:

There are two chains, chain-A and chain-B. 
The ligand is name as "803" with residue number 311. In this system, there is a metal ion, MG.
Today we will use chain-A for our simulation instead of taking both chains. 
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$cp 1cqp.pdb 1cqp.A.pdb

Check if this molecule has disulfide bonds. If yes, write down the bond list. SSbond will need to 
specially bond in LEaP in the following step.

•

Since we are going to simulate only one chain, delete lines which belong to chain-B. Keep the 
molecules in chain-A.

•

$vi 1cqp.A.pdb

The file supposes to contains the protein, LFA-I, and the metal ion, MG, and the compound, 803. 

Prepare a pdb file only contains the receptor.
$ cp 1cqp.A.pdb 1cqp_A_receptor.pdb

Delete ions and ligands. The receptor file is ready for PDB2PQR.
$ vi 1cqp_A_receptor.pdb

Prepare a file which only has ions and crystal water inside.
$ cp 1cqp.A.pdb ion.pdb

Keep only Mg ion and water in the pdb. It will be used for building the complex system. The crystal 

water will be kept in the future calculation.

$ vi ion.pdb

Prepare a file which contains only lovastatin from 1cqp

$ cp 1cqp.A.pdb lova.pdb

Keep only the 803 in the file. And, add "TER" at the first line of the file and last line of the file. 

------------------------------------------------------

TER

HETATM 1472  C1  803 A 311      52.497  19.025  23.052  1.00 43.13      .129 C

HETATM 1473  C2  803 A 311      52.393  17.482  22.971  1.00 36.38      .035 C

HETATM 1474  C3  803 A 311      52.359  16.834  24.377  1.00 33.15      .024 C

HETATM 1475  C21 803 A 311      53.777  16.458  24.857  1.00 27.12      .005 C

HETATM 1476  C4  803 A 311      51.698  17.697  25.428  1.00 31.06      .031 C

HETATM 1477  C24 803 A 311      51.206  18.918  25.189  1.00 35.91      .025 C

:

:

$ vi lova.pdb
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:

:

HETATM 1494  O4  803 A 311      53.678  19.407  23.772  1.00 53.81      .304 O

HETATM 1495  C23 803 A 311      54.765  19.395  22.995  1.00 49.98      .271 C

HETATM 1496  O5  803 A 311      54.734  19.102  21.809  1.00 43.97      .264 O

HETATM 1497  C16 803 A 311      56.030  19.778  23.712  1.00 43.96      .086 C

HETATM 1498  C19 803 A 311      57.059  18.637  23.609  1.00 37.46      .010 C

HETATM 1499  C17 803 A 311      56.607  21.070  23.116  1.00 40.94      .010 C

HETATM 1500  C18 803 A 311      55.592  22.202  23.360  1.00 49.33      .001 C

TER

---------------------------------------------------------

receptor •

ligand•

and its ions, crystal waters. •

Therefore, we will have pdb files of 
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Prepare topology and coordinate files
For this tutorial, you will build the following molecule in the preparatory program called xLEaP for 
simulation in AMBER. 
In order to build and solvate this molecule, you will need to start xLEaP. xLEaP has another command 
line interface and simple molecular graphics for building the system topology and define parameters 
for the molecules.

Add protons on the protein structure
The structure was solved by X-ray so the protons are missing in the PDB file. We need to add protons 
carefully by using the program "PDB2PQR".
$ cd ..
$ mkdir 0_PDB2PQR
$ cd 0_PDB2PQR

The output file 1cqp.pqr is the pdb after adding protons. 

$ /opt/PDB2PQR/pdb2pqr/pdb2pqr --with-ph=7.4 --ph-calc-method=propka --apbs-input --
ff=amber --ffout=amber --verbose --summary ../PDB/1cqp_A_receptor.pdb 1cqp.pqr >pdb2pqr.log 

Prepare topology and coordinate files for the drug-target complex 

Go back to the working folder ~/LFA-1

$ cd .. 

Create a folder for drug-target complex input file

$ mkdir 1_LEaP

$ cd 1_LEaP/

Link the parameter files for the compound to the current directory

$ ln ../0_Gaussian/LVA.lib .

$ ln ../0_Gaussian/frcmod.LVA .

Prepare a full PDB which contains the protonated receptor with the compound pdb and ion pdb 

Take those files prepare in the section-1. 

$ cp ../0_PDB2PQR/1cqp.pqr 1cqp_H.pdb

$ cp ../PDB/1cqp_803.pdb .

#change residue name from 803 to LVA

$ cat 1cqp_803.pdb | sed "s/ 803 / LVA /" > LVA.pdb

$ cp ../PDB/1cqp.pdb MG.pdb

#1,1908d

#2,$d

#:wq

#Leave only MG

$ vi MG.pdb

Section-2: Creating parameters files
2018年2月14日 下午 01:09
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#Leave only MG

#put LVA back. go to the last line of protein

#:r LVA.pdb

#put Mg back. go to the last line of LVA

#:r MG.pdb

#change WAT Atom HW to H1

#:%s/HW/H1/

#change WAT Atom OW to O

#:%s/OW/O /

#:wq

$ vi 1cqp_all.pdb

Start xLEaP now with the xleap command.
$ xleap
-I: Adding /usr/local/amber_14/amber/dat/leap/prep to search path.
-I: Adding /usr/local/amber_14/amber/dat/leap/lib to search path.
-I: Adding /usr/local/amber_14/amber/dat/leap/parm to search path.
-I: Adding /usr/local/amber_14/amber/dat/leap/cmd to search path. You should see a window like 
this: 

Warning:
Do NOT click the "X" on any LEaP window. It will quit LEaP entirely.

Note:
At this point it's a good idea to turn Num Lock off for the menus to work.

Load a protein and nucleic acid force field
A MD force field is the the Hamiltonian (potential energy function) and the related parameters that 
describe the intra- and intermolecular interactions between the molecules in the system. In MD, the 
Hamiltonian is integrated to describe the forces and velocities of the molecules.

The basic form of the Amber Hamiltonian is: 

   Molecular Dynamics Simulation Page 7    



The basic form of the Amber Hamiltonian is: 

In order to run a molecular dynamics simulation, we need to load a force field to describe the 
potential energy of alanine dipeptide. We will use the AMBER force field FF14SB for proteins and 
nucleic acids. FF14SB is based off FF12SB, an updated version of FF99SB, which in turn was based on 
the original Amber Cornell et al (1995) [ff94] force field. The most significant changes to the FF14SB 
force field included updated torsion terms for the protein Phi-Psi angles and refits of the torsion 
terms for side chains. Together these improved the estimation of alpha helices in these molecules.

source (load) the FF14SB force field now.
> source leaprc.protein.ff14SB

Source (load) force field for water model, TIP3P. And, load the force field parameters for metal ions.

>source leaprc.water.tip3p

>source leaprc.gaff2
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Load the parameters for the compound

> frcmods = loadAmberParams frcmod.MOL

>loadOff MOL.lib

Load amber parameters for metal ions which are charge +2,+3, +4 in the force field parameter of 
Lenard-Jons 12-6 in the tip3p water model.
> loadamberparams frcmod.ions234lm_126_tip3p
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Load PDB

> 1cqp = loadpdb all.pdb

> 1cqptip3pbox = copy 1cqp

Solvate the system with the solvatebox command.

> solvatebox 1cqptip3pbox TIP3PBOX 10.0 1 #defualt radii is 1.5

Add ions to neutralize the system

Number of water/Number of salt = 55 000/150

Assuming the targeting salt concentration is 150mM. The water concentration is 55M in the 
solution. Therefore, 

In this system, the total amount of water is about 8518. Thus, the amount of salt ion is about 20. The 
drug-target system is charged –2. In  order to neutralize the system, two sodium ions are addionally 
added. 
> addions 1cqptip3pbox Na+ 22 Cl- 20  
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To save the prmtop and inpcrd file use the saveamberparm command.

> savepdb 1cqptip3pbox 1cqptip3pbox.pdb

> saveamberparm 1cqptip3pbox 1cqptip3pbox.top 1cqptip3pbox.crd

1cqptip3pbox.top 

1cqptip3pbox.crd

Two input files are ready:

And, a pdb of the whole system, 1cqptip3pbox.pdb

Quit XLEaP
> quit

Run tleap in batch
To execute in command mode of LEaP alternatively, you can also prepare a in-file then execute the 
following command. 
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following command. 
$ tleap –f tleap.in
Where tleap.in is listed below:

source leaprc.protein.ff14SB

source leaprc.water.tip3p

source leaprc.gaff2

frcmods = loadAmberParams frcmod.LVA

loadOff LVA.lib

loadamberparams frcmod.ions1lm_126_tip3p

loadamberparams frcmod.ions234lm_126_tip3p

loadoff atomic_ions.lib

1cqp = loadpdb 1cqp_H.pdb

1cqptip3pbox = copy 1cqp

solvatebox 1cqptip3pbox TIP3PBOX 10.0 1

addions 1cqptip3pbox Na+ 24 Cl- 22

savepdb 1cqptip3pbox 1cqptip3pbox.pdb

saveamberparm 1cqptip3pbox 1cqptip3pbox.top 1cqptip3pbox.crd

quit

----------------------------------------------------------

---------------------------------------------------------

tleap

Prepare restraint atom lis
$ ./SelectRestrainedAtoms

Back to the ~/LFA-1
> cd ..
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Minimization1.
Heating with constant volume and temperature (NVT) for 20ps from 0K to 300K2.
Production MD with constant pressure and temperature (NPT) at 300K and 1atm for 1ns3.

The last components needed are the input files that define the program settings for each MD run. For 
this system, we will perform an energy minimization on the system, then slowly heat the system, and 
then do production MD at the desired temperature and pressure. 

We will save the trajectory and write to the output file every 1ps. The Langevin thermostat will be used 
to control the temperature. The random number generator will be initialized with a random seed.

Prepare workspace
$ mkdir 2_MIN
$ cd 2_MIN

Minimization input
Create the file min.in that includes the following settings for minimization: 
File: min.in
------------------------------------------------------------------
&cntrl

    imin=1, irest=0,

    ntc=2, ntf=2,

    ntb=1, cut=10.0, iwrap=1,

    ntmin=2, maxcyc=500, ntpr=50, ntr=1,

&end

restraining 1CQP

5.0

[ATOM list]

:
:
--------------------------------------------------------------------
A list of heavy atoms are restraining to avoid the whole system crash during the minimization step. 
A perl script is ready for extracting the heavy atom automatically. 

$ cp 1_LEaP/1captip3pbox.pdb .

$ ./SelectRestrainedAtoms

$ extractHeavyAtom.pl  1cqptip3pbox_restrained_atoms.pdb > atomlist

Merge the input file and atom list:
$cat min.in atomlist > min_r.in

/ The settings can be summarized as follows:

imin=1 Choose a minimization run

irest=0 Do not restart simulation. (not applicable to minimization)

maxcyc=500 Maximum minimization cycles

ncyc=1000 The steepest descent algorithm for the first 0-ncyc cycles, then switches the conjugate 

gradient algorithm for ncyc-maxcyc cycles

Section-3: Minimizing the system
2018年2月14日 下午 01:10
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gradient algorithm for ncyc-maxcyc cycles

ntpr=50 Print to the Amber mdout output file every ntpr cycles

Link top and crd files in this working folder

$ ln 1_LEaP/1cqptip3pbox.top 2_MIN/.

$ ln 1_LEaP/1cqptip3pbox.crd 2_MIN/.

Execute minimization

Source Amber setup

$ source /opt/setup_amber.sh

Execute sander 

$ mpirun -np 4 $AMBERHOME/bin/sander.MPI -O -i min_r.in -c 1cqptip3pbox.crd -p 1cqptip3pbox.top -
ref 1cqptip3pbox.crd -o min.out -r min.rst

min.out
min.rst      <== this one will be used for the subsequent step.

The files coming from this step of calculation are:

Run in Batch Mode
$ ./RUN
-------------------------------------

#!/bin/sh

source /opt/setup_amber16gnu.sh

ln ../1_LEaP/1cqptip3pbox.crd  .

ln ../1_LEaP/1cqptip3pbox.top  .

mpirun -np 16 $AMBERHOME/bin/sander.MPI -O \

                  -i min_r.in \

                  -c 1cqptip3pbox.crd \

                  -p 1cqptip3pbox.top \

                  -ref 1cqptip3pbox.crd \

                  -o min.out \

                  -r min.rst

-----------------------------------------------

RUN

Back to ~/LFA-1
$ cd ..  
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Prepare working space
$ mkdir 3_MD0

$ cd 3_MD0

Heating input
Create the file md0.in that includes the following settings for heating:

---------------------------------------------------------------------

md, npt, warm to 300K quickly, constant pressure

&cntrl

  imin = 0, irest = 0, ntx = 1,

  nstlim = 100000, dt=0.001, nsnb = 20,

  tempi=0.0, temp0 = 300.0, iwrap=1,

  tautp=0.1, taup=1,

  ntt = 1, ntb = 2, ntp = 1,

  ntc = 2, ntf = 2, cut = 10.0,

  ntwe = 500, ntwx=500, ntr=1,

&end

restraining all

5.0

[ATOM LIST]

:

---------------------------------------------------------------------

ntx=5 Read coordinates and velocities from unformatted inpcrd coordinate file

irest=1 Restart previous MD run [This means velocities are expected in the inpcrd file and will be 

used to provide initial atom velocities]

temp0=

300.0

Thermostat temperature. Run at 300K

ntb=2 Use periodic boundary conditions with constant pressure

ntp=1 Use the Berendsen barostat for constant pressure simulation

Copy the atom list generated from last step in 2_MIN

> cp ../2_MIN/atomlist .

Merge input file together with atom list

> cat md0.in atomlist > md0_r.in

Section-4: Heating-up the system
2018年2月14日 下午 01:11

   Molecular Dynamics Simulation Page 15    



Link top and crd files in this working folder

> ln 1_LEaP/1cqptip3pbox.top 3_MD0/.

> ln 1_LEaP/1cqptip3pbox.crd 3_MD0/.

Execute heating-up
Source Amber setup

$ source /opt/setup_amber.sh

Execute pmemd  

$ mpirun -np 4 $AMBERHOME/bin/pmemd.MPI -O \

                      -i md0_r.in \

                      -c ../2_MIN/min.rst \

                      -p 1cqptip3pbox.top \

                      -o md0.out \

                      -e md0.en \

                      -ref 1cqptip3pbox.crd \

                      -x md0.trj \

                      -r md0.rst

Back to ~/LFA-1

$ cd ..
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Prepare working space
$ mkdir 4_MDN

$ cd 4_MDN

Production MD input
Create the file mdN.in that includes the following settings for heating:
----------------------------------------------------------------------------------------
md, npt, warm to 300K quickly, constant volume

&cntrl

  imin = 0, irest = 1, ntx = 5,

  nstlim = 100000, dt=0.001,

  tempi=300.0, temp0 = 300.0, nscm=500,

  ntt = 1, npscal = 1, ntb = 2, ntp = 1, tautp=0.01, taup = 0.01,

  ntc = 2, ntf = 2, cut = 9.0,

  ntwx= 100, ntwe = 100, ntwv=100,

  iwrap=0,

/

------------------------------------------------------------------------------------------

Create the file RUN_MD that includes the following commands:
-----------------------------------------------------------------------------------------

#! /bin/sh

source /opt/setup_amber.sh

ln ../2_MIN/1cqptip3pbox.top .

ln ../2_MIN/1cuqtip3pbox.crd .

ln ../3_MD0/md0.rst .

mkdir RST OUT EN FRC VEL TRJ

cp md0.rst RST/

pseq=0

seq=1

while [ $seq -le 10 ]

do

        mpirun -np 4 $AMBERHOME/bin/pmemd.MPI -O \

                      -i mdN.in \

Section-5: Production MD
2018年2月14日 下午 01:11
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                      -c RST/md$pseq.rst \

                      -p 5cuqtip3pbox_1264.top \

                      -o OUT/md$seq.out \

                      -e EN/md$seq.en \

                      -v VEL/md$seq.vel \

                      -ref 5cuqtip3pbox_1264.crd \

                      -frc FRX/md$seq.frc \

                      -x TRJ/md$seq.trj \

                      -r RST/md$seq.rst

        pseq=`expr $pseq + 1`

        seq=`expr $seq + 1`

done

--------------------------------------------------------------------------------------------------

Launch production MD 
Change command mode by adding executable option

$ chmod +x RUN_MD    

Execute the command

$ ./RUN_MD &

*Add "&" at the end of command is to execute the command in the background 

The total duration of production MD here is 10ns. Every loop is 1ns. The RUN_MD contains 10loops. 
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Visualize the result
You've now run an MD simulation. In order to visualize the results, we will now use Chimera to check 
the outcoming structures and trajectory.

Open the software chimera
$ chimera

Load the crystal structure and make the superimpose of these two structures. 

"File -> open " open the crystal structure which has chain A only. 

Section-6: Analyzing the results
2018年2月14日 下午 01:11
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Go to "Tools -> MD/Ensemble Analysis -> MD Movie"
A small window will pop out for selection of Prmtop and trajectory. 
In our case, we need to choose "1cqptip3pbox.top" as our Prmtop.
And, the trajectory can be selected according to the run sequence. 

     

Go to the small movie panel and select "Per-Frame -> Define script"
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Input "mm #1 #0" and click "Apply"

And centering the molecule in the display. Find a proper view to see the compound. 

After selecting the proper top file and trajectory, simply click "OK"
The molecule will show together with salt and some contacting waters. To have a clear view of the 
compound and the receptor, we can unselect the water and salt.
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compound and the receptor, we can unselect the water and salt.

"Select -> Residue -> Cl-"
"Actions -> Atoms/Bonds/ -> hide"
"Select -> Residue -> Na+"
"Actions -> Atoms/Bonds/ -> hide"

Select salt and hide bonds and atoms:

"Select -> chain -> water"
[Ctrl + Shift ] mouse select the target water which is closed to MG. 
"Actions -> Atoms/Bonds -> hide"

Color the compound:
Open command mode

"Select -> Residue -> LVA"
"Actions -> Color -> forest green"
"Actions -> Color -> by heteroatoms"
"Clear selection"

> select #1:184

Go to the small movie window and play. 
If you would like to record a movie, you can go to "File -> Record movie.. "

Name the file and click "Record".

Analyze the MD results
Amber includes a suite of tools to examine and analyze MD trajectories. In this tutorial, we will do a 
simple analysis with several Amber programs and plot the results. The analysis will primarily done 
from the command line in the terminal.

Open a terminal and change directory to your tutorial files. 
$ cd ~/LFA-1

Make an Analysis directory and change to that directory. 
$ mkdir Analysis
$ cd Analysis 
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$ cd Analysis 
Now we will use an analysis script process_mdout.perl to analyze the MD output files. This script will 
extract the energies, temperature, pressure, density, and volume from the MD output files and save 
them to individual data files.

Process the MD output files with process_mdout.perl 
$ source /opt/setup_amber.sh 
$ process_mdout.perl  ../3_HEAT/md0.out
It is now quite simple to plot the data saved in the output files.

----

summary_avg.DENSITY  summary_avg.TSOLVENT  summary_rms.DENSITY  summary_rms.TSOLVENT

summary_avg.EKCMT    summary_avg.VOLUME    summary_rms.EKCMT    summary_rms.VOLUME

summary_avg.EKTOT    summary.DENSITY       summary_rms.EKTOT    summary.TEMP

summary_avg.EPTOT    summary.EKCMT         summary_rms.EPTOT    summary.TSOLUTE

summary_avg.ESCF     summary.EKTOT         summary_rms.ESCF     summary.TSOLVENT

summary_avg.ETOT     summary.EPTOT         summary_rms.ETOT     summary.VOLUME

summary_avg.PRES     summary.ESCF          summary_rms.PRES

summary_avg.TEMP     summary.ETOT          summary_rms.TEMP

summary_avg.TSOLUTE  summary.PRES          summary_rms.TSOLUTE

-----

We will use gnuplot to automatically generate plots for the following MD simulation properties 
throughout the simulation. We use this for our convenience, but you can use any plotting program 
of your choice.

MD simulation temperature1.
MD simulation density2.
MD simulation total, potential, and kinetic energies.3.

However, for the MD simulation density, the heating portion of the simulation does not include a 
density output. You will need to edit the summary.DENSITY file to remove the empty data points for 
gnuplot to work.

Go into gnuplot:
$ gnuplot

    G N U P L O T

    Version 4.6 patchlevel 2    last modified 2013-03-14 

    Build System: Linux x86_64

    Copyright (C) 1986-1993, 1998, 2004, 2007-2013

    Thomas Williams, Colin Kelley and many others

    gnuplot home:     http://www.gnuplot.info

    faq, bugs, etc:   type "help FAQ"

    immediate help:   type "help"  (plot window: hit 'h')

Terminal type set to 'x11'

gnuplot> set term png
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gnuplot> set term png
gnuplot> set output "DENSITY_time.png"
gnuplot> set xlabel "time(ps)"
gnuplot> set ylabel "Density"
gnuplot> plot "summary.DENSITY" w l title "Density vs. Time"
gnuplot> q

Output file will be "DENSITY_time.png".

We can use the similar way to produce temperature profile or total energy profiles.
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CPPTRAJ
This tutorial will give a brief overview of analyzing simulation data with CPPTRAJ. CPPTRAJ is the 
successor to PTRAJ, with many additional features. Some basic and common types of analysis will be 
covered, as well as the basics of data set handling in CPPTRAJ. In addition, gnuplot will be required to 
view some of the output data. 

Running in Batch Mode

Instead of running interactively, CPPTRAJ can also be run using one or more input files. Since the log 
file 'cpptraj.log' has recorded every command used, you can use the log file as the basis for a cpptraj 
"script". For example to generate everything we have done so far the following input could be used: 

Input file: trj_dist_temp.in

--------------------------------------------------------------------------------------------------

parm 1cqptip3pbox.top

trajin TRJ/mdtemp.trj

distance D1 :183@O1 :130@OH out dist_LVA_O1-TYR130_OH_temp.dat

distance D2 :183@C3 :108@CD1 out dist_LVA_C3-ILE108_CD1_temp.dat

distance D3 :183@C20 :106@CG1 out dist_LVA_C20-VAL106_CG1_temp.dat

distance D4 :183@C21 :171@CD1 out dist_LVA_C21-LEU171_CD1_temp.dat

distance D5 :183@C18 :175@CD1 out dist_LVA_C18-LEU175_CD1_temp.dat

distance D6 :184@MG :12@OG out dist_MG-SER12_OG_temp.dat

distance D7 :184@MG :14@OG out dist_MG-SER14_OG_temp.dat

distance D8 :184@MG :112@OD1 out dist_MG-ASP112_OD1_temp.dat

distance D9 :184@MG :233@O out dist_MG-WAT233_O_temp.dat

distance D10 :184@MG :238@O out dist_MG-WAT238_O_temp.dat

distance D11 :184@MG :246@O out dist_MG-WAT246_O_temp.dat

distance D12 :184@MG :79@OG1 out dist_MG-THR79_OG1_temp.dat

---------------------------------------------------------------------------------------------------

We use "distance" command to extract the distance between lovastatin and its binding pocket as 
well as the Mg ion to its nearby molecules. 
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well as the Mg ion to its nearby molecules. 

Run script "run_cpp_distance.sh"

$ ./run_cpp_distance.sh

dist_LVA_O1-TYR130_OH.dat
dist_LVA_C3-ILE108_CD1.dat
dist_LVA_C20-VAL106_CG1.dat
dist_LVA_C21-LEU171_CD1.dat
dist_LVA_C18-LEU175_CD1.dat
dist_MG-SER12_OG.dat
dist_MG-SER14_OG.dat
dist_MG-ASP112_OD1.dat
dist_MG-WAT233_O.dat
dist_MG-WAT238_O.dat
dist_MG-WAT246_O.dat
dist_MG-THR79_OG1.dat

Output files will be:

We can use "gnuplot" as well to plot those files. 
$ gnuplot
gnuplot> set term png
gnuplot> set output "[the output filename]"

The plot will present inside the output file.
gnuplot> plot "[the file-1 you wish to plot]" w l, "[the file-2 you wish to plot]" w l

gnuplot> q
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